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CBA HR

Introduction
 

Thank you for choosing the West Mountain Radio Computerized Battery Analyzer (CBA). The CBA is a powerful 

test instrument that measures, graphs, and compares performance of both primary and secondary (rechargeable) 

batteries and individual cells.  The CBA allows for the precise measurement of battery capacity and takes the 

guesswork out of choosing the best battery for your application.

 

The CBA is much more than a simple battery voltage tester or a battery load tester. It will test virtually any type 

or size of battery, any chemistry or number of cells, up to 55 volts. Now anyone can do scientific battery tests for 
a reasonable price.

 

The CBA alone is capable of tests up to a maximum of either 40 amps or 150 watts for short periods of time. 

For continuous operation, suggested values are 20 amps or 100 watts, whichever is higher.  When used with an 

optional amplifier, tests can be done at 500 watts. 
 

The CBA not only tests the total amount of energy stored in a battery (capacity in amp-hours), but also graphically 

displays and charts the voltage versus time using a constant current load. Graphs may be displayed, saved 

and printed, and the axis parameters can be changed at anytime.  Multiple test graphs of the same battery, or 

multiple batteries, may be compared or overlaid; a very useful feature. Battery test data may be printed in color 

or black and white to paper or convenient test labels to put directly on the tested batteries. An optional external 

temperature probe provides automatic over temperature test cutoff.
 

The CBA is ruggedly built and supplied with 12 gauge wire and Powerpole® connectors for battery test 

connections.  It is small with a high performance cooling system and quiet fan. LED indicators are visible from 

across a room that display communication and test status.

 

Standard software supplied with the CBA is easy to use, intuitive, and designed to protect both the CBA and 

batteries being tested.  It provides automatic sensing of battery cell count, a safety check of the test rate, and 

recommends a minimum safe discharge voltage. There are user editable and recallable battery test profiles and 
Capacity Discharge tests may be viewed in Amp Hours, Watt Hours or Minutes. The Charge Monitor Test mode 

charts and records voltage rise during a charge or discharge. Lab calibration current adjustment is a standard 

user feature to improve accuracy for testing at very low discharge rates, or for critical applications.

 

The optional Extended Software license provides all the features of the standard version, but adds five additional 
test modes: Time Discharge, Duty Cycle, Constant Power, Multiple Discharge and Constant Resistance. Results 

can be graphed as Voltage vs. Amp hours, Watt hours, Minutes or Ragone depending on the type of test.  Ragone 

graphs require the weight of the battery/batteries to be accurate. 
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Powerpole® is a registered trademark of Anderson Power Products

A CBA IV enables another test: Power Profile.  This test is very useful for power supply testing or solar cell 
analysis.  The resulting graph displays Voltage vs. Amps or Watts. The Extended Software version also adds 

the ability to graph battery temperature with CBA III and CBA IV (when the optional temperature probe is 

connected). An additional lab calibration feature makes it possible to compensate for test lead resistance, 

giving accurate readings at the battery terminals.

 

When using a CBA III with a 500W Amplifier, Extended Software is required.
When using a CBA IV with a 500W Amplifier, Standard or Extended Software will  provide provisions for 
operation with amplifiers for testing at high discharge rates or doing destructive testing.
 

CBA HR

Specifically designed to test and evaluate small cells and batteries – those capable of supplying quite low 
discharge currents.  Such small cells must be evaluated using even greater measurement precision than what 

is capable with CBA IV model.  Designed to precisely test virtually any small size battery, any chemistry or 

number of cells, from 0.7 to 10 volts. The CBA HR is capable of testing batteries at load currents from 1 mA to 

1000 mA, (10 watt maximum), in increments of 1 mA.  

 

An optional 4-wire test harness improves voltage measurement accuracy by minimizing the voltage sensing 

lead wire resistance effect.  Some optional harnesses also include an external magnetic probe, which when 
used with optional Extended Software allow logging of battery / ambient temperature and automatic over-

temperature test cutoff.
 

Standard Software is supplied with the CBA HR.  In addition to the four basic test modes included with the 

CBA IV (Mission Profile, Discharge, Charge Monitor, and Power Profile), the CBA HR adds two additional test 
modes (Duty Cycle and Multiple Discharge) to allow user simulation of real world battery load variations found 

in typical remote sensor sleep / transmit applications.  

 

The optional Extended Software license provides the ability to graph battery temperature when the optional 

magnetic temperature probe is connected. This optional temperature probe is included in selected test harness 

assemblies and is connected to the CBA HR via a 3.5mm accessory input. 

 

The CBA HR is not designed to be used with optional West Mountain Radio 500 watt CBA Amplifiers.  For 
higher test currents and voltages that exceed the CBA HR’s ratings - use the West Mountain Radior CBA IV, 

which can accommodate one or more 500W Amplifiers.
  CBA IV Specifications
 

Electrical
•	 Maximum continuous discharge rate: 100 watts

•	 Maximum limited term discharge rate with < 3500 ma-hour battery: 125 watts

•	 Maximum limited term discharge rate with < 1000 ma-hour battery: 150 watts

•	 0-3 amp accuracy: typically better than + - 10 mA

•	 3-40 amp accuracy: typically better than + - 45 mA

•	 0-5 volt accuracy: typically better than + - .005 volts

•	 5-15 volt accuracy: typically better than + - .01 volts

•	 10-60 volt accuracy: typically better than + - .05 volts

•	 Maximum operating voltage: 55 Volts (48 Volt Lead Acid Telecom supported)

•	 Maximum discharge rate: 40 Amps (Battery dependent, 100 watt continuous)

•	 Minimum discharge voltage to maintain 30 Amps 0.9 Volts (Battery dependent)

•	 Minimum Voltage for a 40 Amp discharge: 2 Volts at completion of test (Battery dependent)

•	 Minimum discharge rate: 0.01 Amps (10 mA)

•	 Residual current drain, battery connected while not in use: < 3 mA @ 12 volts
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Hardware / Software
•	 High performance micro controller with USB interface and 12 bit A/D conversion

•	 USB powered: CBA does not use battery being tested to run the CBA or fan

•	 Computer Interface:  USB Type A to B (Cable Included)

•	 Load Connections (Battery Test):  Powerpole (+) / (-)

•	 I/O Port:  5 pin flat header for Temp Input & Serial Port
•	 LED indicators: System ready and Test in progress, viewable from across a room

•	 Internal over temperature sensing and protection

•	 Internal user replaceable fuse:  ATO / ATC 25 Amp ; ships with spare 40 Amp

•	 Graph printing on any standard color or B&W printer
•	 Battery test label printing on standard 5110

 

CBA HR (High Resolution) Specifications
 

Electrical
•	 Maximum continuous discharge rate: 10 watts

•	 Maximum discharge current:  1000 mA  (1.0 Amp)

•	 Minimum discharge current:  1.0 mA  (0.001 Amp)

•	 Discharge Current Accuracy:  better than +/- 20 uA @ 1 mA discharge

•	 Maximum operating test voltage:  10 volts

•	 Minimum operating test voltage:  0.7 volts

•	 Voltage reading accuracy:  better than +/- 0.01 volts

•	 Residual current drain, battery connected while not in use: < 200 uA @ 9 volts

 

Hardware / Software
•	 High performance micro controller with USB interface and 12 bit A/D conversion

•	 USB powered: CBA does not use battery being tested to run the CBA or fan

•	 Computer Interface:  USB Type A to B (Cable Included)

•	 Load Connections (Battery Test):  Powerpole (+) / (-)

•	 I/O Port:  3.5 mm for Temp Input & Remote Voltage sensing (4-wire) – when using temperature input, remote 
voltage sensing harness must also be used

•	 LED indicators: System ready and Test in progress, viewable from across a room

•	 Internal over temperature sensing and protection

•	 Internal user replaceable fuse:  ATO / ATC 2 Amp

•	 Graph printing on any standard color or B&W printer
•	 Battery test label printing on standard 5160 / 8160 stick-on labels

•	 Dimensions: 1.5” H x 2.8” W x 3.6” D

•	 Weight: 4 oz.
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 Safety Precautions
 

The West Mountain Radio CBA family of battery testers are inherently safe, but the batteries being tested are 

not. Any system that stores energy is potentially dangerous.  Some types of batteries are safer than others, but 

all are capable of causing explosions or fires.
 

For technical information on a specific battery, refer to the Battery Manufacturers website.  Most battery 
labels have limited information, but the manufacturer’s website usually includes more detailed technical 

information.  General information for batteries is also available on the West Mountain Radio CD.  Select Battery 

Information and FAQs.

 

Primary Safety Considerations:
 

•	 Never discharge a battery at a higher discharge rate than it was designed for.

•	 Never use a battery that has poorly insulated, frayed wiring, or exposed metal parts.

•	 Never connect a battery with reverse polarity.

•	 Never test a battery near flammable materials.
•	 Never allow a battery to reach a temperature that is too hot to touch.

•	 Recharge batteries immediately with an appropriate battery charger after the test is completed. Some 

types do not like to remain discharged for extended periods of time.

•	 Never test or charge batteries while unattended.

•	 Always have a fire extinguisher nearby.
 

CBA Operating Requirements:
 

•	 Never connect a battery with the polarity reversed.

•	 Always connect the USB cable to the CBA BEFORE connecting the battery.

•	 Be aware the heatsink of the CBA is at battery potential (positive terminal of battery).

•	 Never connect a battery to the CBA if that battery is connected to something else.

•	 Contact West Mountain Radio for support before connecting to a USB hub.

•	 Operate the CBA in a cool dry location.

•	 Never allow metal parts or wiring of the battery to come in contact with the metal heat sink of the CBA.

•	 Never allow the cooling fan to be blocked or jammed.

•	 Do not ignore the warnings from the CBA Software.

•	 The CBA can get hot. Do not touch the metal heat sink while, or shortly after, conducting a high power 

test.

 

Lead Acid Battery Safety Warnings:
 

Adhere to all safety considerations with lead acid batteries, especially while charging.  These batteries, especially 

automotive and marine types, give off explosive hydrogen gas when charged.  A nearby or internal spark or 
flame can cause a lead acid battery to explode sending liquid acid and lead shrapnel in all directions.  This is 
particularly dangerous and frequently causes blindness or severe scarring injuries.

Never use a standard lead acid battery without proper ventilation.  Sealed lead acid batteries such as gelled or 

AGM (absorbed glass mat) types are much safer.  Automotive and marine types are not as safe and should be 

used in protective ventilated housings.

 

Never make the last connection to a lead acid battery that may cause a spark on the terminal.  Always connect 

the load or charger last, and at a safe distance away from the battery.
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NiCad, NiMh, and Alkaline Safety Warnings:
 

Adhere to all safety considerations, as these types of batteries can also be dangerous.  If they are shorted 

out or charged/discharged at too high a rate, they can overheat and explode.  A single D size NiCad cell can 

actually melt a 10 penny (9 gauge) nail (it is not recommended to attempt.)

  

Lithium Safety Warnings:
Reprinted with permission of the Academy of Model Aeronautics

Words in bold and ( ) were added by West Mountain Radio

 

Lithium Battery Fires

Lithium batteries are becoming very popular for powering the control and power systems in our models. This 

is true because of their very high energy density (amp-hrs/wt. ratio) compared to NiCads or other batteries. 

With high energy comes increased risk in their use. The, principal, risk is FIRE which can result from improper 

charging, crash damage, or shorting the batteries. All vendors of these batteries warn their customers of this 

danger and recommend extreme caution in their use. In spite of this many fires have occurred as a result of 
the use of Lithium Polymer batteries, resulting in loss of models, automobiles, and other property. Homes and 

garages and workshops have also burned. A lithium battery fire is very hot (several thousand degrees) and is 
an excellent initiator for ancillary (resulting) fires. Fire occurs due to contact between Lithium and oxygen in the 
air. It does not need any other source of ignition, or fuel to start, and burns almost explosively.

 

These batteries must be used in a manner that precludes ancillary fire. The following is recommended:
 

1. Store, and charge (discharge), in a fireproof container; never in your model.
2. Charge (discharge), in a protected area devoid of combustibles. Always stand watch over the charging 

(discharging), process. Never leave the charging process unattended.

3. In the event of damage from crashes, etc, carefully remove to a safe place for at least a half hour to 

observe. Physically damaged cells could erupt into flame, and, after sufficient time to ensure safety, 
should be discarded in accordance with the instructions which came with the batteries. Never attempt 

to charge (discharge) a cell with physical damage, regardless of how slight.

4. Always use chargers designed for the specific purpose, preferably having a fixed setting for your 
particular pack. Many fires occur in using selectable/adjustable chargers improperly set. Never attempt 
to charge Lithium cells with a charger which is not specifically designed for charging Lithium cells. 
Never use chargers designed for Nickel Cadmium batteries.

5. Use charging systems that monitor and control the charge state of each cell in the pack. Unbalanced 

cells can lead to disaster if it permits overcharge of a single cell in the pack. If the batteries show any 

sign of swelling, discontinue charging, and remove them to a safe place outside as they could erupt into 

flames.
6. Most important: NEVER PLUG IN A BATTERY AND LEAVE IT TO CHARGE (DISCHARGE), 

UNATTENDED OVERNIGHT. Serious fires have resulted from this practice.
7. Do not attempt to make your own battery packs from individual cells.  These batteries CANNOT be 

handled and charged casually such as has been the practice for years with other types of batteries. The 

consequence of this practice can be very serious resulting in major property damage and/ or personal 

harm.
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Primary Safety Considerations:
 

•	 Never discharge a battery at a higher discharge rate than it is designed for.

•	 Never use a battery that has poorly insulated or frayed wiring or exposed metal parts.

•	 Never connect a battery with reverse polarity.

•	 Be aware the heatsink of the CBA is at battery potential (positive terminal of battery).

•	 Never test a battery near flammable materials.
•	 Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch.

•	 Recharge batteries immediately with an appropriate battery charger after tests are completed. Some 

types do not like to remain discharged for extended periods of time.

•	 Never test or charge batteries while unattended.

•	 Always have a fire extinguisher nearby.
 

Liability Disclaimer
West Mountain Radio will not be liable to you (whether under the law of contract, the law of torts or otherwise) 

in relation to the contents of, or use of, or otherwise in connection with, the CBA (“product”):

•	 To the extent that the product may cause any bodily or equipment damage;

•	 For any indirect, special or consequential loss of any kind;

•	 For any business losses, loss of revenue, income, profits or anticipated savings, loss of contracts or 
business relationships, loss of reputation or goodwill, or loss or corruption of information or data.

 

By using this product, you agree to the limitations of liability set forth in this disclaimer are reasonable.
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Getting Started
 

It is recommended to read this entire manual and help files for a full understanding of the CBA and software 
operation.

 

1. From the CD ROM opening screen, click on “Software and Hardware Installation”.  Follow the instructions 

on the screen to complete both the hardware and software installations.

2. Connect the CBA to the PC’s USB port using the supplied cable before connecting a battery. 

 

NOTE: If the Windows message “Found new Hardware” appears, the previous step was not completed.
3. Start the West Mountain Radio CBA program. 

 

NOTE: For a CBA III the green LED will come on when the program starts. For CBA IVHR the LED will light as 
soon as the drivers are installed.  The software should start with a “New Test” screen in the “Auto-Check” profile.

 

4. In the “New test” window select the “Battery Type” (chemistry) and select or type in the “Capacity Ah”. 

 

NOTE: To convert mAh (milliampere hours) to Ah (Ampere hours) divide by 1000. If the capacity rating is not 
printed on the battery contact the manufacturer or visit their web page.

5. Connect the battery with very short, solid, low resistance connections using the proper connectors and polarity.   

 

WARNING: Be certain that you have the polarity correct.  For Standard convention: RED to RED, 

BLACK to BLACK, and PLUS to PLUS, MINUS to MINUS.

6. The battery voltage will display the resting fully charged battery voltage on the right side of the screen. Click 

the ‘Detect’ button for the software to suggest some baseline settings after selecting the chemistry type. 

 

If the number of cells or average pack voltage is not correct, check that the proper battery type was 

entered.  If sure the average pack voltage or cell count is incorrect, change the software estimate to the 

correct value in either the “Voltage” or “Cells”.

7. The discharge current in the “Test Amps” can also be suggested by the software by clicking ‘Suggest’. 

This calculation is based on the battery capacity and chemistry type.  If preferred to run a test at 
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different discharge rate, change the “Test Amps” window.    
 

WARNING: Do not choose a higher discharge rate than the battery is capable of.  See the the 

battery manufacturer’s specifications. 
 

NOTE: If the no load battery “Voltage” multiplied times the “Test Amps” selected (Volts x Amps = Watts) exceeds 
the wattage rating of the CBA, or the default recommended maximum discharge rate for a given battery type, 
the software will prompt to lower the discharge current before starting a test.  The CBA will run tests at up to 150 
watts, for short periods of time, with a battery that has a rated capacity of 1 Amp-Hr or less, up to 125 watts below 
3.5 Amp-Hrs and 100 watts for any capacity battery.  The CBA HR will run tests up to 10 watts, with maximum 
voltage of 10 volts and maximum current of 1 Amp.

8. Type in a “Test Name” for the test that positively identifies the test for future reference, perhaps write a 
number on the battery and use that number, or a unique description of the battery and the test.

9. Press the “Start” button in the “New Test” window. Optionally press “OK” and use the    button or 

selecting “Test --> Start” 

 

If the settings are correct notice the graph will appear and auto-scale.  The red LED on the CBA will 

come on and the fan will start. The virtual LED and fan on the right panel will start also.  The “Current” 

will ramp up to the “Test Rate” value and the voltage will start to record on the graph.   

10. The test will continue until the test “Cutoff V” is reached.  At that point the test will automatically 
stop and the program will beep and display “Test Complete”.  Everything will return to the 

stopped condition ready for another test or to save the file. Disconnect the battery at this time.   
 

WARNING: Do not ever leave a battery connected after a test completes!  Leaving a battery in 

a discharged state for prolonged period of time could over discharge and damage the battery.  

 

CAUTION: The battery and the CBA may be HOT

11. When the test is complete go to the “File” menu and save the file if desired.   
 

NOTE: The file name will default to the test name but it may be changed to another name if desired.  If the 
program is closed or another test is run, a prompt will ask if wanting to save the completed test already on the 
screen.  One filename can contain multiple test names.

12. To start another test, start at step 4 of these instructions.  Click the  button or “Test--> New.” .  When 

starting the new test, a prompt will ask if desire to save the previous test and start a new test or add that 
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test to the graph on the screen.

 

After running a discharge test on a rechargeable battery, the battery should be recharged. Most batteries are 

rated for many recharge cycles depending on the battery type and on the discharge rates, sometimes 1000’s 

of cycles.  Most batteries should not be left at their fully discharged cutoff voltages but should be stored in a 
partially charged state for maximum battery life.  Discharged batteries should also be promptly disconnected 

from the CBA to prevent its small parasitic draw from further reducing the battery voltage, which in some cases 

could eventually decrease voltage to a point that might compromise battery life.

 

Program Features
 

The installation and basic operation is covered in the Getting Started section of this manual and Help file. This 
section gives a detailed explanation of using the program and its features.

 

 

 

File Menu
 

New:

Starts a new test document. This will initialize a new blank graph.

 

Overlay:

Allows for opening a saved test document and to overlay the tests in that file over the test graph or graphs 
already on the screen as long as they are the same type. Once there is a series of graphs for battery comparison 

on the screen, these may be saved under an existing or new file name.
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NOTE: If there are test graphs on the screen no longer wanted, right click on the graph trace and select “Delete test” to 
remove that graph trace.
 

When selecting properties, it is possible to change the graph style, but only if the test was done and saved on 

Version 2 or later of the software.

 

Open:

Opena any saved file.  Old test files from the previous version 1 of CBA software may be opened by changing 
“Files of type” from .bt2 to .bt1.  When opening and displaying an old style .bt1 file, at the time of saving, it will 
be converted to the new .bt2 and saved in the new format.

 

Close:

Will close the file displayed on the screen and prompt to save it.
 

Save:

Saves the test document graph currently displayed on the screen.

 

Save As:

Saves a test under a new file name as a copy or to save the same file in a different folder location.
 

Export:

Converts the test file to .CSV (Comma Separated Values) comma separated file format and allows it to be 
saved for data manipulation with a spreadsheet program such as Excel®, or  a text viewer.

 

Print, Print Preview and Print Labels:

For a discussion of printing functions refer to the help section on printing.
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Recent Files:  

A convenient way to open files that were recently used from a list of the last eight files.
 

Exit:

Closes the program and will prompt to save a file of the tests on the screen.
 

Test Menu
 

New Test:

Opens a “New Test” window. This new test can be appended to the currently open graph or file.
 

Start, Stop, Properties:

These will be grayed out unless a “New Test” window was created and selected “OK” instead of “Start”.  If 

available, then start a test or stop a test in progress.  Properties will allow you to change the test name before 

starting a test or graph type at any time.

 

Chart Properties:

Allows for change to the graph scaling or put a title on the graph

Tip: It is recommended not to change the graph scaling as the automatic scaling works very well.

 

 

Tools menu
 

Preferences:

Ability to customize certain settings for the program such as “Temperature Units” (degrees C or F), Charting 

Options, and End of Test alerts

 

 

“Save window size and position” causes the program to come back with the same window the next time you 

open it.

 

“Open last file(s) on startup” causes the program to reopen the displayed test data next time the program is 
stated.

 

“Stop test when battery temperature reaches” “xx degrees” - allows for test termination when a battery exceeds 

the set point temperature – requires optional magnetic Temperature Probe to be attached to battery being tested.
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“Print charts in black-and-white” is for setting display to code the test line graphs for identity when not color 

coded.

 

“Anti-Alias chart text” smoothens the text graphics.

 

“Anti-Alias chart graphics” smoothens the graph graphics.

 

Audio tone and Repeat tone allow for audio notification when a test has ended. 
 

Lab Calibrate:

“Tools”, “Lab Calibrate”, depending on the software license (Standard or Extended) and hardware versions, 

provides options for calibration of Temperature, Discharge Current, and test lead Voltage drop. These are 

advanced options and should only be used by technically competent users having access to laboratory calibration 

standards.

 

 

Temperature Calibrate: 

The optional temperature probe may be calibrated at room temperature by comparing it to a room temp 

thermometer.  For highest accuracy place a lab grade thermometer and the CBA temperature probe in water 

heated to the temperature of interest for testing.  Calibration consists of setting the software value to read the 

exact temperature show on the lab-grade thermometer.  Enter this value in either degrees C or F window.

 

In the standard version of the software the temperature is displayed and the temperature may be used as a 

safety feature to automatically stop a test at a user set maximum battery temperature.

 

 

Current Calibrate:

An advanced option that only functions below 3 Amps. If there is a need for the most precise measurements and 

access to a lab quality ammeter that has known NIST traceable calibration, this option is available. This option 

allows a calibration offset to center the CBA’s calibration within a 12 bit window. In other words, it is possible to 
adjust the discharge current in 1 mA increments but only within a 10 mA measurement window (applies to CBA 

IV, the CBA HR has 1 mA discharge current accuracy).  A change may not be noticeable unless it is on the cusp 

of switching to the next 12 bit data level. This feature is useful to calibrate at especially low discharge rates below 

500 mA. Do not use this option without complete understanding.  For best accuracy at low discharge currents 

(below 1 amp) use a CBA HR.
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Voltage Calibrate is grayed out and only available with an Extended License (or as standard with the CBA HR).  See 

the section of the manual on Extended Software Features.

 

CBA HR makes it is possible to use laboratory grade instruments to more precisely calibrate the voltage reading 

(at a specific current level) to better compensate for lead-wire voltage drop between the test battery and CBA HR 
internal sensing circuits.  For highest precision, you may wish to use an optional 4-wire test connection harness, 

which routes the voltage sensing leads into the CBA HR via its 3.5 mm accessory connector.  When a 3.5 mm 

plug is inserted, the CBA HR changes its voltage sensing from the large Powerpole current leads, to the 3.5 mm 

accessory connector (which is then extended to the test battery terminals via optional harness).

 

 

Help
 

Contents, Index, Search:

Access to these files directly from the program instead of from the CD-ROM or our web page.
 

About CBA:

Displays the current software version running on your computer.  To determine the firmware revision within the 
CBA hardware, select Tools > CBA Devices.
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Test Configuration
 

To begin testing a battery click “File-->New” or the  button.

 

Notice that the “New Test” window defaults to the “Profile” “<Auto-Check> and is in the auto check mode. This 
profiles only needs the basic information to run a test, and the software will do the rest. Be sure to provide the 
“Test Name”, the “Battery Type” (chemistry) and provide the battery’s rated “Capacity”.

 

 

Profile
Profile defaults to “<Auto Check>” which causes the program to automatically recommend appropriate test 
discharge current and cutoff voltage from the user entered “Battery Type” and “Capacity”. It then reads battery’s 
fully charged voltage and makes a cell count estimate and recommends a test cut-off voltage and discharge 
current. This profile only requires the basic information to run a test, and the software will do the rest. Be sure to 
provide the “Test Name”, the “Battery Type” (chemistry) and provide the batteries rated “Capacity”.  

 

A user may manually override any parameter and run a test or save those custom settings as a new “Profile”. 
To add and save a new profile, use the mouse to highlight “<Auto Check>”. Then type in an appropriate name 
for a new custom profile name. The program will ask to save it as a new profile or update the information for the 
existing “<Auto Check>” information.

 

After saving a profile or profiles, recall them by typing in part of the profile name or selecting it from the drop 
down menu.

 

NOTE: If a saved profile was selected and then test parameters are changed, a prompt will ask to save those changes to the 
existing profile, or allow you to save the profile under a new name.  
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If a profile is no longer needed, highlight it and use the “Delete” button to the top right of the “New Test” window.
 

Battery Type
The “Battery Type”, drop-down selection, must be chosen correctly in order for the software to recommend how 

to test that particular type of battery.  Select the type of battery you are about to test.   

 

NOTE: If using an unusual type of battery that is not on the list, it is recommended to select Other/Custom and then 
manually set the test parameters. If unsure about any parameters - review the battery specifications or contact the battery 
manufacturer or contact West Mountain Radio.
 

Voltage
This is the rated average pack or cell voltage (average of a discharge cycle) of a battery, not the fully charged 

voltage which is actually measured by the CBA when a battery is first connected (and displayed on right-side of 
main screen).  In the “<Auto Check>” mode this is automatically calculated from the user provided battery type 

information and from the CBA’s reading of the fully charged battery voltage. 

 

Verify this voltage is correct before starting a test!  

 

NOTE: Manually changing this will also change the battery cell count.
 

Cells
This represents the number of series cells estimated to be in the pack.  Using the “Detect” button will let the 

software estimate this automatically. Verify the number of cells is correct before starting a test!  

 

Detect Button
Clicking here will fill in “Voltage” and “Cutoff V:” based on the current CBA reading. Additionally using the Battery 
Type, the number of cells will be estimated.

 

Capacity
The “Capacity” (Ah): is the rated capacity of the battery in Ah (Ampere Hours).  This must be typed in or selected 

in order for the software to recommend an appropriate discharge rate.  Normally this information is on a sticker 

on the battery, otherwise contact the manufacturer.  If the capacity is in mAh (milliampere Hours) divide by 1000 

to convert to Ah.

 

Weight
The “Weight” of the battery is optional information, not needed to run a test. It is saved with the file and is needed 
to plot a Ragone graph but only with the Extended version software upgrade.

 

Test Name
This is a required field and a test cannot be started without a test name. Be sure to choose a name which identifies 
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the battery and the current test so that it may identify the test in the future. It is suggested that, depending on the 

testing application, a naming convention be adopted. 

 

NOTE: The software automatically records battery chemistry, Ah rating and the discharge rate with every battery test. A saved 
file may contain multiple tests.  If desired, take advantage of this feature by saving files containing multiple tests within that 
file name.  Include the date and/or time in the test name to identify a test among a series of tests of the same battery.  Identify 
your batteries with unique labels tied to the test file name.
 

Test Cutoff Voltage
The program will automatically recommend the “Test Cutoff V” (voltage at which the test and discharge stops) 
that is appropriate for the chemistry selected in the “Battery Type”.

 
NOTE: 100% discharge is never 0 volts for any type of battery.  There is an industry standard for each chemistry.  Lead-Acid 
battery 1.775 volts per cell; nickel 0.9 volts per cell and lithium 2.8 volts per cell. The 100% discharge voltages may vary 
slightly between different manufacturers and may be dependent on temperature. It is recommended to verify this voltage 
from battery manufacturers’ specifications.
 

NOTE: It is possible to manually change the cutoff voltage for any reason, but do so with caution.  Do not lower the voltage 
without good reason as most batteries can be damaged due to over discharge. Lead and lithium chemistries are particularly 
susceptible to this type of damage. It is commonly believed that nickel cells actually benefit from discharge to 0 volts if they 
are then quickly re-charged. However, a pack of nickel cells should never discharged to near zero volts as a pack of cells could 
become unbalanced and damaged. The software will give a warning before starting a test if you have lowered the test cutoff 
voltage below recommendations.
 
NOTE:  Raising the Cutoff voltage will cause the load test to terminate at an earlier point, with a resulting decrease in the 
amount of energy depleted from the battery during the test.  If a battery fails to provide the energy expected, insure the Cutoff 
voltage was correctly set.
 

Test Type
Normally this would be set to Discharge.  A Discharge Test provides a regulated constant current discharge. The 

other test option featured in the standard version is Charge Monitor which uses the CBA as a recording voltmeter to 

chart voltage versus time for evaluation of a charger.  A CBA IV enables additional standard tests, one for power 

supply characterization: Power Profile and also Mission Profile.  A CBA HR enables the same tests as included with 

the CBA IV, plus adds Duty Cycle and Multiple Discharge. 
 

The Extended License allows for additional tests to become available including, Timed Discharge, Constant Resistance, 

Constant Power, Multiple Discharge, and Duty Cycle. 
 

A West Mountain Radio CBA Charger Interface board provides the ability to perform a Charge Discharge Test.

 

WARNING: Never hook the CBA to a battery that has something else connected that is not totally ground 

isolated.  To test a charger in the charge monitor mode the charger must be totally electrically isolated 

from the computer ground.

 

Sample Rate
Sets how often data is added to the graph.  Faster value will add more data to the graph, which gives more 

resolution to the test results, but results in larger test files.  Long tests, such as discharging a lead-acid battery at 
1/20 C, can use longer values as the battery voltage will not move very fast.  This is only available to users with 

Extended Software License.
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CBA Amplifiers
 

Notice the amplifier selection buttons are now available allowing use of one to four CBA Amplifiers. Be careful 
NOT to check these buttons if the test setup does not include properly connected and active amplifiers. If the test 
does include amplifiers, ensure they are connected and turned on and YOU MUST check the appropriate button 
so the software sets and records the current correctly. Amplifiers have a current gain of 10X and a power rating of 
500 watts each. The software reduces the CBA current draw to the corresponding level and records the current 

and power that would be measured at the battery terminals.

 

The “New Test” header includes the CBA serial number and name and indicates that the software is registered 

to run the Extended features enabled.

 

The CBA HR is designed for high resolution, precise current testing and cannot operate CBA Amplifiers.

Tests
 

Mission Profile (CBA IV Only)
 

This is a simplified discharge test that can be used for application specific testing. Using values from the “real-
world” application in which the battery will be used, you may test several different batteries to see which one is 
best suited. There is an option to run a test until it meets the requirements of the application (Pass) or run until 

the battery is depleted. If the battery is depleted before the minimum time is reached, the test fails - while going 

beyond the minimum time is a pass.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.

 

Average Current Draw:  

The amount of current that will be drawn by the “real-world” system you are using should be entered in this 

field. The CBA will draw this amount of current from the battery until the minimum duration is met or the battery 
depleted.

 

Minimum Duration:  

How long the battery will be used in minutes.  When the time of the test reaches or surpasses this point the test 

will Pass.

 

Automatically stop when minimum duration is reached: 

Selecting this option will either end the test when the battery is depleted or after the number of minutes specified 
in the Minimum Duration field. Whichever comes first.
 

Discharge Test
 

This is a classic test for measuring and analyzing battery capacity. Using a constant current discharge, the 

battery voltage lowers until the cutoff voltage is reached and the test stops. Optionally, using a temperature 
probe, the battery temperature can be monitored and kept within safe levels. The Extended License enables 

users to not only graph temperature but also, when the temperature limit is reached, have a recovery time for the 

battery temperature to lower and allow the test to then continue.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.
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Tests Amps:  

This field specifies the desired discharge rate. Using the battery specifications, enter a safe discharge rate that 
will not exceed the capability of the battery you are testing. Click the ‘Suggest’ button to have the CBA software 

make a suggestion for a typical discharge rate..

 

Graph:  

View the graphical results for a Discharge test in Amp Hours, Watt Hours, Minutes or, with an Extended License, 

Ragone. This can be changed at any time during the test or after it is completed, and also when opening a saved 

file. To do this, right click on the graph area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.
 

Graph Temperature: 

This is an Extended License feature allowing to graph the battery temperature side by side with the battery data. 

A Voltage versus Time graph is recommended for this option.

 

Recovery Time: 

This setting is enabled with an Extended License and allows the test to pause and the battery to “Recover” when 

the temperature gets above a user specified limit (as set in Tools > Preferences). After the recovery time expiries the 

test resumes until the test is stopped or the voltage cutoff is reached.
 

Capacity Check: 

This feature allows to verify  the battery capacity correlates to the manufacturer claimed battery capacity. Ensure 

the capacity window on the new test prompt matches the battery to be tested. This information is usually found 
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on a sticker on the battery. If unable to find the battery capacity, contact the battery manufacturer. The default 
Threshold is 80% and has a range of 50% to 100% of the specified capacity. Thus,  2200 mAh battery must 
supply at least 2.2 Ah * 80% = 1.76 Ah before the voltage drops below the cutoff voltage. A pass or fail result is 
indicated in the legend and the status bar. A vertical dotted line on the graph indicates the Ah required to pass.

 

Capacity Type:  

Select from Percent, Minimum Amp Hours, or Minimum Watt Hours as the pass Threshold. Using the suggest 

button will make the Threshold 80% of the battery capacity.

 

 

Timed Discharge Test
 

This test will discharge the battery until the user specified duration has expired, and then stop the test.  This 
differs from the normal Discharge test, which would discharge a battery until the cutoff voltage has been used.  A 
typical application of this test is to discharge the battery to a certain capacity, for example, a Lithium battery that 

needs to be at 30% charge before shipping.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
 

 

Test Amps: 
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This is the current, in Amps, that the CBA will draw from the battery/supply during the test.

 

Graph: 

View the graphical results for a Discharge test in Amp Hours, Watt Hours or Minutes.  This can be changed at 

any time during the test or after it is completed, and also when opening a saved file.  To do this, right-click on the 
graph area and choose ‘Chart Properties’.  Or select “Test --> Chart Properties”.

 

Duration: 

This is how long to perform the test.  Once this duration has expired the test will stop.  The test may stop 

prematurely if the voltage of the battery hits the cuttoff Voltage (see Cutoff V parameter).
 

Units: 

This specifies the length of the duration parameter, and can be either seconds, AmpHours, WattHours or percent.
 

Starting Percentage and Ending Percentage: 

If percent was used for the duration unit, then the duration field is replaced with these two fields.  The test will 
discharge the battery to the specified ending percentage based on the Ah capacity of the battery.  The starting 
percentage field is used to specify the present capacity of the battery.  For example, if the starting capacity of a 
100Ah battery is entered as 75% and the ending capacity is 10%, the test will attempt to discharge 65% of the 

battery, or 65Ah.

 

Capacity to be Discharged: 

If Percent was used for the duration unit, this field shows the final Ah value that the test will attempt to discharge 
based on the Capacity (Ah), starting percentage and ending percentage fields. The purpose of this display is to 
verify the duration, in Ah, that the test is going to perform before starting the test.

 

Charge Monitor Test
 

WARNING:  Never hook the CBA to a battery that has something else connected that is not totally ground 

isolated.  To test a charger in the charge monitor mode, the charger must be totally electrically isolated 

from the computer ground.

 

This test will use the CBA to graph voltage versus time.  Using this test, the CBA will strictly be used to monitor 

the voltage; the CBA will not draw any load from the battery.  This test is useful to monitor the voltage of a battery 

as it is being charged and can also allow the CBA to be used as a recording voltmeter for any source up to the 

CBA’s maximum voltage limit.

 

Information about the Battery section and Sample Rate can be found in the Test Configuration section of the Help.

  

Max Time: 

This field should be greater than the typical charge time for your selected battery.  In the case of using the CBA 
as a recording voltmeter, this field will determine how long the recording function will continue (up to 168 hours).
 

Graph: 

Minutes is only available graph type for this Test Type.

 

Graph Temperature: 

An Extended license will allow you to graph the temperature of your charging batterybattery, or record the 

ambient temperature during a long term recording voltmeter session.  Note this also allows the CBA to act as a 

long term (up to 168 hour) recording temperature instrument, with a 1 second sample rate.
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Power Profile (CBA IV and CBA HR Only)
 

This test is extremely useful for characterizing different power supplies, solar cells and batteries. The voltage 
current relationship is extremely useful and the data gathered will allow your power supply to operate at optimum 

power output and efficiency. This test continuously increases the load by the Current Increment while the voltage 
is graphed versus current or versus power. Using a voltage versus power graph, the peak power output of a 

battery or power supply can be accurately measured.  In similar manner, this test may be used to investigate the 

maximum power point (MPP) of a solar panel.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.

 

 

Current Increment: 

The test begins with a load of zero amps and increases the load on the battery or power supply at a rate specified 
in Hold Time until the Cutoff Voltage or the Cutoff Current is reached; or the CBA becomes Current Limited 
(because the 150 Watt max power rating has been reached). If the CBA is Current Limited in a Power Profile 
test, the test will end.

 

Cutoff Current: 
Using the battery specifications, enter a Cutoff Current that will not exceed the limitations of the battery being 
tested.  When the load becomes greater than this value the test will end. For example a current increment of 

1.5 and a cutoff current of 12 will graph 9 points (test begins at zero amps) if the Voltage does not fall below the 
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cutoff.
 

Graph: 

Data for this test type can be displayed in Voltage versus Amps or Watts. By graphing in Watts, the maximum 

power output is represented by the right most data point.  Data can also be displayed in Watts versus Amps.

 

Hold Time:

This specifies how long, in seconds, the current will be maintained until the software reads the voltage and 
increment the current to the next step.

 

Duty Cycle (Extended Software)
 

The duty cycle test is particularly valuable when attempting to evaluate the performance of a battery in an 

application which typically involves a cyclic or variable duty cycle. This test is much more exact and repeatable 

than manually pausing a test or starting and stopping multiple tests.  Duty Cycle test is included with the CBA 

HR to help simulate battery usage in small remote devices which wake up occasionally to report (transmit) their 

status, followed by a prolonged sleep period.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.
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Load Type:

This field selects the type of CBA load presented to the battery being tested.  The CBA can simulate 3 different 
load types – Current, Resistance, or Power.  Selection of the load type results in the box below it changing 

accordingly, allowing the user to program the actual load to be maintained in constant Amps, Ohms, or Watts.

 

Current - Operating as a Current load type, the test battery will be depleted during the CBA’s “on” time period 

using a constant current (Amps) load, as determined by the value set in the “Current” box.  In this mode, the 

CBA effectively lowers its internal load resistance as the test battery voltage falls, thus maintaining the discharge 
current at a constant amp level throughout the test.

Resistance – Operating as a Resistance load type, the test battery will be depleted during the CBA’s “on” time 
period using a constant resistance (Ohms) load, as determined by the value set in the “Resistance” box.  In this 

mode, the CBA maintains a constant ohmic value load on the test battery, thus allowing the discharge current to 

decrease proportionally as the test battery voltage falls during the test (per ohms law).

 

 

Power – Operating as a Power load type, the test battery will be depleted during the CBA’s “on” time period 
using a constant power (Watts) load, as determined by the value set in the “Power” box.  In this mode, the CBA 

varies its internal resistance to maintain a constant wattage load on the test battery, thus compensating for the 

decreasing test battery voltage as the test proceeds (per ohms law, where Power = Voltage x Current).

 

Period On: 

This is the number of seconds the battery will be discharged at the given rate.  Valid settings range from 5 to 

9999 seconds.

 

Period Off: 
The load current will drop to zero amps during this off-time period and will continue at zero load for the number 
of seconds specified here. Valid settings range from 5 to 9999 seconds.  The duty cycle will be  Pon  / (Pon + 
Poff).  This discharge test will continue to cycle in this On/Off time pattern until the test battery voltage falls below 
the value programmed in the “Cutoff V” box.
 

Graph: 

A Duty Cycle test may be viewed graphically in Amp Hours, Watt Hours or Minutes. This can be changed at any 

time during the test or after it is completed, and also when opening a saved file. To do this, right click on the graph 
area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.

 

NOTE: When graphing in AmHrs or WattHrs the cycle may not be apparent and therefore it is suggested to 

display in Minutes.

 

 

Constant Power (Extended Software)
 

You may also run a test with constant power instead of constant current. With this test mode the load current will 

be constantly increased as the battery voltage decreases over time. Useful for batteries that are used in systems 

which require consistent power.

 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.
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Watts: 

Use this field to specify desired load discharge Power in Watts. Using the manufacturer’s battery specifications, 
enter a safe value that will not exceed the ratings of the battery testing. Also note, the CBA without amplifiers has 
a power limitation of 150Wand CBA HR is limited to 10W.

 

Graph: 

Graphical results for a Constant Power test may be viewed in Amp Hours, Watt Hours or Minutes. This can be 

changed at any time during the test or after it is completed, and also when opening a saved file. To do this, right 
click on the graph area and choose ‘Chart Properties’. Or select “Test > Chart Properties”.

 

 

Multiple Discharge (Extended Software and CBA HR)
 

Battery applications that experience a variety of different current loads, such as a variable number of running 
motors, can be simulated using this Multiple Discharge test. This test allows realistic and real-time analysis of 

performance under highly variable load conditions. When entering the load conditions, use the manufacturer’s 

battery specifications to enter a safe discharge rate that will not exceed the ratings of the battery being tested.
 

Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 

Configuration section of the Help.
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